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1.1 Up-To-The-Minutes Notes

Latest notes that arrived after close of editorial work will be placed in the appendix and are
available in English only. 
 

1.2 Other Literature Provided

Along with the installation package of So
distribution media. Most of that literature is provided as PDF
installation of the Adobe Reader ™. This reader is not part of the 
downloaded from www.adobe.com
 
Further information about this release of the product can also be found under
 
www.schneider-electric.com
Products and Services > Automation and Control > PAC, PLC & other Controllers>
Controllers (PLC) for Commercial machines
SoHVAC 

 
In addition use the documentation that is provided along with the hardware components you are
going to use in your SoHVAC project.
 
Take care that you have received the necessary manuals of the hardware components, read them
carefully and follow carefully the instruction given to operate the devices.
 

22  PPRROODDUUCCTT  OOVVEERRVVIIEEWW
SoHVAC is the software solutio
provides one common tool, one connection, one project file and one download interface to develop, 
configure, program and commission the company’s machine control system 
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3.1 Supported Operating Systems

This software can be installed on the following operating systems:
 

• Microsoft Windows 
 
Following software is required

• Adobe reader to view
o If Adobe is not installed it can be downloaded from the A

http://get.adobe.com/reader/
• Internet Explorer or Mozilla Firefox

 
 

AATTIIOONN  

Minutes Notes 

Latest notes that arrived after close of editorial work will be placed in the appendix and are

Other Literature Provided 

Along with the installation package of SoHVAC you will find additional literature on the
distribution media. Most of that literature is provided as PDF-formatted documents that require the
installation of the Adobe Reader ™. This reader is not part of the SoHVAC 

www.adobe.com 

Further information about this release of the product can also be found under

electric.com 
cts and Services > Automation and Control > PAC, PLC & other Controllers>

Controllers (PLC) for Commercial machines> OEM machine programming software 

In addition use the documentation that is provided along with the hardware components you are
going to use in your SoHVAC project. 

Take care that you have received the necessary manuals of the hardware components, read them
carefully and follow carefully the instruction given to operate the devices. 

WW  
is the software solution developed specifically for OEM HVAC&R machine builders that 

provides one common tool, one connection, one project file and one download interface to develop, 
configure, program and commission the company’s machine control system 

EENNTTSS  

ported Operating Systems 

This software can be installed on the following operating systems: 

Microsoft Windows 7 ( 32 bit and 64 bit) 

Following software is required: 
view help files 

If Adobe is not installed it can be downloaded from the Adobe website 
http://get.adobe.com/reader/ 

Internet Explorer or Mozilla Firefox to view reports 

 

Latest notes that arrived after close of editorial work will be placed in the appendix and are 

you will find additional literature on the 
formatted documents that require the 

 installation but can be 

Further information about this release of the product can also be found under 

cts and Services > Automation and Control > PAC, PLC & other Controllers> 
> OEM machine programming software - 

In addition use the documentation that is provided along with the hardware components you are 

Take care that you have received the necessary manuals of the hardware components, read them 

machine builders that 
provides one common tool, one connection, one project file and one download interface to develop, 
configure, program and commission the company’s machine control system  

dobe website 



 

3.2 PC Hardware Requirements

 
System Pentiu
RAM Memory Minimum 
Hard Disk minimum available 
Drive DVD reader; 
Display SVGA 1024 × 768
Peripherals A mouse 
Peripherals USB interface
Web Access No registration required
 

3.3 Required User Access Right

• You have to log-in with administration rights before you start installation of SoHV
You must not launch the installation with normal user rights and change role in course of 
installation. 
 

• You have to log-in with administration r
rights are required to generate the application program
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The SoHVAC Software can be downloaded from the following FTP server 
 
FTP: ftp.fr.schneider-electric.com
Login: HVAC 
Password: HVAC 
 
The directory: /HVAC/Fieldtest/SoHVAC V
SoHVAC_3.0.0.0_Setup.exe
DownloadManager_V3.8.1.0_Setup.exe
 
The SoHVAC Software is not available on DVD media.
 

4.1 Installation Hints 

Before installing SoHVAC 3
SoHVAC versions. 
 
To start the installation process, 
wizard, which will guide you through the installation process.
 
 

4.2 Installation on computers with Windows 7 operating system

To start the installation process, select the "
key and select "Execute as Administrator". Follow the installation wizard, which will guide you 
through the installation process.
 
To execute SoHVAC under Windows 7, d
menu. A user account control message box will appear
SoHVAC software. 

Requirements 

Pentium processor 2,0 GHz or higher 
Minimum 1 GB; recommended: 2GByte  
minimum available free space 500 MB 
DVD reader;  
SVGA 1024 × 768 pixel resolution or higher  

mouse or compatible pointing device 
USB interface 
No registration required 

Required User Access Rights  

in with administration rights before you start installation of SoHV
You must not launch the installation with normal user rights and change role in course of 

in with administration rights before you execute SoHVAC.
rights are required to generate the application program 

FFTTWWAARREE  

The SoHVAC Software can be downloaded from the following FTP server  

electric.com 

/HVAC/Fieldtest/SoHVAC V3.0.0.0 contains the following files 
.0.0_Setup.exe 

.0_Setup.exe 

is not available on DVD media. 

3.0.0.0 on your computer you need to remove previous installed 

To start the installation process, run the "SoHVAC_3.0.0.0_Setup.exe" file. Follow the installation 
wizard, which will guide you through the installation process. 

computers with Windows 7 operating system

To start the installation process, select the "SoHVAC_3.0.0.0_Setup.exe" file and click right mouse 
key and select "Execute as Administrator". Follow the installation wizard, which will guide you 

lation process. 

To execute SoHVAC under Windows 7, double click SoHVAC or call SoHVAC from Windows start 
A user account control message box will appear, like the figure below. 

 

in with administration rights before you start installation of SoHVAC 
You must not launch the installation with normal user rights and change role in course of 

te SoHVAC. Administrator 

on your computer you need to remove previous installed 

file. Follow the installation 

computers with Windows 7 operating system 

etup.exe" file and click right mouse 
key and select "Execute as Administrator". Follow the installation wizard, which will guide you 

ouble click SoHVAC or call SoHVAC from Windows start 
, like the figure below. Click on Yes to start 



 

 

 
Proceed with Yes and the installation wizard for SoHVAC V3.0.0.0
through the steps 
 

 
 
 

  

installation wizard for SoHVAC V3.0.0.0 will start 

 

 

 and will guide you 

 



 

At the end of the SoHVAC ins
compiler is required to build the M168 binary files for downloading in the M168 controllers.
 

 
 
In case the Fujitsu compiler is already installed on your computer, you do not need to install it 
again. In that case you nee
menu: Tools / Preference …
 
 

4.3 Registration 

SoHVAC does not require software

4.4 Uninstall 

To uninstall SoHVAC software, start
As an alternative you uninstall the SoHVAC software using
provided by the Windows control panel.
 

The Fujitsu compiler is not 
compiler can be uninstalled using the 
control panel. 
 
 
 

At the end of the SoHVAC installation, you will be asked to install the Fujitsu compiler. The Fujitsu 
build the M168 binary files for downloading in the M168 controllers.

In case the Fujitsu compiler is already installed on your computer, you do not need to install it 
again. In that case you need to set the path to the compiler in the SoHVAC software under the 
menu: Tools / Preference … 

software registration. 

software, start the installation process again and select the “Remove” operation.
uninstall the SoHVAC software using the “Add/Remove Programs” 

provided by the Windows control panel. 

The Fujitsu compiler is not automatically uninstalled by the SoHVAC uninstall function. The Fujits
compiler can be uninstalled using the “Add/Remove Programs” function provided by the Windows 

 

tallation, you will be asked to install the Fujitsu compiler. The Fujitsu 
build the M168 binary files for downloading in the M168 controllers. 

 

In case the Fujitsu compiler is already installed on your computer, you do not need to install it 
d to set the path to the compiler in the SoHVAC software under the 

the “Remove” operation. 
the “Add/Remove Programs” function 

uninstall function. The Fujitsu 
“Add/Remove Programs” function provided by the Windows 
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5.1 Communication between PC & Controllers

The connection between PC & Controllers is 
communication cables:  
- USB-A to RJ11 
- USB-A to USB-A 
-  
For the 23 I/O controllers, 17 I/O expansion modules and the electronic expansion valve drivers use 
the USB-A to RJ11 programming cable
 
The communication port must be configured in the SoHVAC
Tools\Preferences… 
 
For the 8 I/O controller use the USB
 
The communication port is automatically detected and it is not needed to configure the port in the 
SoHVAC software 
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6.1 Operating limits 

6.1.1 New functions in SoHVAC

The SoHVAC 3.0.0.0. software supports the following new functions
- Support new hardware; TM168B08***** 
- Analog output with PWM (0..2kHz)
- Modbus master function block supporting function codes for digital coils
- New firmware for the electronic expansion valve driver supporting R407F refrigerant
- New Fieldbus profile generator V1.8.3. 
- BACnet EDE export 
- Enhanced BMS editor (multiple objects)
- Simulator for algorithm editor
 

6.1.2 Screen resolution 

The optimum screen setup used by SoHVAC
some windows may not be correctly displayed.
The optimum screen resolution
configurations, some windows may not be correctly displayed.
 

6.1.3 Serial port initialization

When software starts, the 
to this COM port, it will be reset. To avoid this, the controller
programmer.  

 
Each time the user changes the 
once you close the window.

AATTIIOONN  

Communication between PC & Controllers 

The connection between PC & Controllers is using the programming cable. There are 

For the 23 I/O controllers, 17 I/O expansion modules and the electronic expansion valve drivers use 
A to RJ11 programming cable 

The communication port must be configured in the SoHVAC software under the menu 

I/O controller use the USB-A to USB-A programming cable. 

The communication port is automatically detected and it is not needed to configure the port in the 

New functions in SoHVAC V3.0.0.0 

software supports the following new functions 
new hardware; TM168B08*****  

Analog output with PWM (0..2kHz) 
Modbus master function block supporting function codes for digital coils

or the electronic expansion valve driver supporting R407F refrigerant
New Fieldbus profile generator V1.8.3.  

Enhanced BMS editor (multiple objects) 
Simulator for algorithm editor 

The optimum screen setup used by SoHVAC is 96 DPI (Dot Per Inch). In other configurations,
some windows may not be correctly displayed. 

resolution used by SoHVAC is 1280 x 1024 DPI (Dot Per Inch). In other 
some windows may not be correctly displayed. 

ort initialization 

When software starts, the default COM Port is initialized by the software. If controller is connected 
to this COM port, it will be reset. To avoid this, the controller must be disconnected from the 

Each time the user changes the default COM Port the software makes a COM port initialization 
once you close the window. If a controller is connected to the newly selected COM port at the time 

 

. There are 2 types of 

For the 23 I/O controllers, 17 I/O expansion modules and the electronic expansion valve drivers use 

software under the menu 

The communication port is automatically detected and it is not needed to configure the port in the 

 
or the electronic expansion valve driver supporting R407F refrigerant 

96 DPI (Dot Per Inch). In other configurations, 

DPI (Dot Per Inch). In other 

If controller is connected 
must be disconnected from the 

efault COM Port the software makes a COM port initialization 
If a controller is connected to the newly selected COM port at the time 



 

of the COM port initialization, that controller will be reset. T
application, and all volatile data is re
default values. 

 

 

6.1.4 Performance 

The SoHVAC project opening time and SoHVAC project compilation time depend
of graphical objects used in the project. The performance can be improved using following 

• Use c-algorithms instead of function block
may cover the functionality of many

• Use c-algorithms for repetitive functions
• Use library functions instead of template functions

open its sub sheets and therefore reducing the number of graphical objects.
 
The SoHVAC V3.0.0.0 has made significant performance improvements in the compilation time. If 
the compiler cache is enabled, see Tools 
times faster compared to SoHVAC 1.0.0.0. 
 

6.1.5 Expansion bus 

The expansion bus is used
to remote user interfaces. A maximum of 32 devices can be connected to the expansion bus. 

The number of devices which can be connected to the expansion bus depends
architecture and the type of devices. 
expansion modules differs from an architecture of 1 controller and many IO expansion modules 
and remote display.  

 
During system tests it is identified that there is a
bus network and the number of devices on the 
network is a multi-master network, by increasing the number of devices, it will increase the 
communication over the network.  The following table indicates the recommended maximum 
number of devices versus the baudrate, where the debug function is disabled.
baudrate on the network, it will reduce the maximum length of the expansion bus.
recommended maximum number is an indication, but might be less depending on the application, 
the device types on the network, debug mode enabled

 

port initialization, that controller will be reset. That is, the controller stops executing
application, and all volatile data is re-initialized. In addition, all the outputs will fall

The SoHVAC project opening time and SoHVAC project compilation time depend
of graphical objects used in the project. The performance can be improved using following 

algorithms instead of function blocks.  C-algorithms are much more compact and 
may cover the functionality of many different function blocks 

algorithms for repetitive functions.  
Use library functions instead of template functions. Library functions prevent the user to 
open its sub sheets and therefore reducing the number of graphical objects.

has made significant performance improvements in the compilation time. If 
the compiler cache is enabled, see Tools \ Preference menu in SoHVAC, the compilation time is 4
times faster compared to SoHVAC 1.0.0.0.  

The expansion bus is used to connect the controller to other devices such as I/O Expansions and 
to remote user interfaces. A maximum of 32 devices can be connected to the expansion bus. 

which can be connected to the expansion bus depends
and the type of devices. An architecture of multiple controllers and multiple IO 

expansion modules differs from an architecture of 1 controller and many IO expansion modules 

During system tests it is identified that there is a correlation between the baudrate of the 
network and the number of devices on the expansion bus network. As the 

master network, by increasing the number of devices, it will increase the 
network.  The following table indicates the recommended maximum 

of devices versus the baudrate, where the debug function is disabled.
baudrate on the network, it will reduce the maximum length of the expansion bus.

maximum number is an indication, but might be less depending on the application, 
the device types on the network, debug mode enabled- 

 

hat is, the controller stops executing its 
initialized. In addition, all the outputs will fall back to their 

 

The SoHVAC project opening time and SoHVAC project compilation time depends on the number 
of graphical objects used in the project. The performance can be improved using following rules: 

are much more compact and 

. Library functions prevent the user to 
open its sub sheets and therefore reducing the number of graphical objects. 

has made significant performance improvements in the compilation time. If 
Preference menu in SoHVAC, the compilation time is 4-5  

as I/O Expansions and 
to remote user interfaces. A maximum of 32 devices can be connected to the expansion bus.  

which can be connected to the expansion bus depends on the network 
An architecture of multiple controllers and multiple IO 

expansion modules differs from an architecture of 1 controller and many IO expansion modules 

correlation between the baudrate of the expansion 
network. As the expansion bus 

master network, by increasing the number of devices, it will increase the 
network.  The following table indicates the recommended maximum 

of devices versus the baudrate, where the debug function is disabled. By increasing the 
baudrate on the network, it will reduce the maximum length of the expansion bus. The 

maximum number is an indication, but might be less depending on the application, 



 

 
 
 

6.2 Documentation 

The documentation is updated, 
The following section describes the 
 

6.2.1 Download applications

In order to download applications to the TM168B08***** controller, connect a USB
programming cable between the PC and t
Click on the download icon in the SoHVAC software. The software will automatically detect the 
communication port and no configuration is needed in the SoHVAC software.
 
 

6.2.2 Analog outputs with PWM 

The new TM168*08***** controllers has
outputs. The maximum frequency is 2kHz.
The frequency for the analog output is a property of the analog output entity.
The input of the analog output entity defines the ratio of PWM signal in 0..100% (2 d
 

6.2.3 BACnet EDE files support

In a multi vendor system, 
From the native BACnet point of view it is not really required to have data point lists, because data 
of object properties from any device can be discovered online using the appropriate BACnet 
services. But depending on the BACnet functionality supported by server device or cli
may be necessary to have this information in form of an offline description. This also is required, if 
the client needs to be set-
 
The Engineering Data Exchange (EDE) template shall
data point types, data point addresses and special data point presentation information in a 
standardized form.  

The Engineering Data Exchange template shall provide a common means to describe the objects 
of a data point server in the form of a Microsoft ® Excel spreadsheet. 

 

updated, and has passed the safety review process. 
The following section describes the latest changes which are not included in the technical literature

Download applications 

In order to download applications to the TM168B08***** controller, connect a USB
programming cable between the PC and the M168 controller. 
Click on the download icon in the SoHVAC software. The software will automatically detect the 
communication port and no configuration is needed in the SoHVAC software.

Analog outputs with PWM  

The new TM168*08***** controllers has 1 analog output which can be used also as PWM analog 
outputs. The maximum frequency is 2kHz. 
The frequency for the analog output is a property of the analog output entity.
The input of the analog output entity defines the ratio of PWM signal in 0..100% (2 d

BACnet EDE files support 

 engineering data need to be exchanged between the interacting parties. 
point of view it is not really required to have data point lists, because data 

of object properties from any device can be discovered online using the appropriate BACnet 
services. But depending on the BACnet functionality supported by server device or cli
may be necessary to have this information in form of an offline description. This also is required, if 

-up before the server device is operational on the network. 

The Engineering Data Exchange (EDE) template shall help to exchange engineering data, such as 
data point types, data point addresses and special data point presentation information in a 

The Engineering Data Exchange template shall provide a common means to describe the objects 
a point server in the form of a Microsoft ® Excel spreadsheet.  

 

 

 
latest changes which are not included in the technical literature. 

In order to download applications to the TM168B08***** controller, connect a USB-A to USB-A 

Click on the download icon in the SoHVAC software. The software will automatically detect the 
communication port and no configuration is needed in the SoHVAC software. 

analog output which can be used also as PWM analog 

The frequency for the analog output is a property of the analog output entity. 
The input of the analog output entity defines the ratio of PWM signal in 0..100% (2 decimals) 

engineering data need to be exchanged between the interacting parties. 
point of view it is not really required to have data point lists, because data 

of object properties from any device can be discovered online using the appropriate BACnet 
services. But depending on the BACnet functionality supported by server device or client device, it 
may be necessary to have this information in form of an offline description. This also is required, if 

up before the server device is operational on the network.  

help to exchange engineering data, such as 
data point types, data point addresses and special data point presentation information in a 

The Engineering Data Exchange template shall provide a common means to describe the objects 



 

 

To create EDE files, open the fieldbus profile generator from the Tools menu in soHVAC. The 
following dialog window will be opened,

Through the File menu, open a DDXML file or Profile.bin 
subdirectory BMS under the projects directory.

Once the file is opened the window will look like below:

To create EDE files, open the fieldbus profile generator from the Tools menu in soHVAC. The 
following dialog window will be opened, 

Through the File menu, open a DDXML file or Profile.bin file. These files can be found in the 
subdirectory BMS under the projects directory. 

Once the file is opened the window will look like below: 

 

To create EDE files, open the fieldbus profile generator from the Tools menu in soHVAC. The 

 

file. These files can be found in the 



 

 

Pressing the Export To CSV button 

 

6.2.4 New Library function 

The new TM168*08***** controller supports reading analog input in resistance value

AI_To_RESISTANCE 

 

Function Block Diagram 

 

Functional Description 

The AI_To_RESISTANCE library converts an analog input value in a resistance value in ohm.

The function works correctly with the following configuration: 

Pressing the Export To CSV button will generate the BACnet EDE files in CSV 

Library function AI_To_Resistance 

The new TM168*08***** controller supports reading analog input in resistance value

The AI_To_RESISTANCE library converts an analog input value in a resistance value in ohm.

The function works correctly with the following configuration:  

 

 

will generate the BACnet EDE files in CSV format. 

The new TM168*08***** controller supports reading analog input in resistance value 

The AI_To_RESISTANCE library converts an analog input value in a resistance value in ohm. 



 

• The analog input must be configured as RESISTANCE input. 

• The AI pin must be directly connected to a real analog input (out pin of ANALOGIN library) 
and not to a CJ_ANALOG variable. 

Example 

 

Input Pin Description 

 

Input Type 

In CJ_ANALOG 

 

Output Pin Description 

 

Output Type 

out CJ_LONG 

 

6.2.5 New Library function LCDBacklightTimeout

LCDBacklightTimeout 

Function Block Diagram 

 

Functional Description 

The LCDBacklightTimeout library allows you to set the value of the LCD backlight timeout 
duration for the M168 controller build in display. The LCD backlight timeout is only active when 
the LCD is configured as “Time” in the LCDBacklight library. 

To set the value, adjust the value property of the P_LCD_BacklightTimeout parameter present in 
the library. 

To understand how to change a parameter value, refer to the SoHVAC Software User Manual.

The analog input must be configured as RESISTANCE input.  

The AI pin must be directly connected to a real analog input (out pin of ANALOGIN library) 
and not to a CJ_ANALOG variable.  

 

Range 

Value: -32768...32767  

Error: 0...2  

 

Range 

-2147483647...2147483648  

Library function LCDBacklightTimeout 

library allows you to set the value of the LCD backlight timeout 
duration for the M168 controller build in display. The LCD backlight timeout is only active when 
the LCD is configured as “Time” in the LCDBacklight library.  

ue property of the P_LCD_BacklightTimeout parameter present in 

To understand how to change a parameter value, refer to the SoHVAC Software User Manual.

 

The AI pin must be directly connected to a real analog input (out pin of ANALOGIN library) 

Description 

Sensor input 

Description 

Resistance value in 

ohm 

library allows you to set the value of the LCD backlight timeout 
duration for the M168 controller build in display. The LCD backlight timeout is only active when 

ue property of the P_LCD_BacklightTimeout parameter present in 

To understand how to change a parameter value, refer to the SoHVAC Software User Manual. 



 

NOTE: This is a single instance library.

NOTE: This is a template type library.

 

Input Pin Description 

 

Input Type 

In CJ_BYTE 

 

Output Pin Description 

 

Output Type 

out CJ_BYTE 

 

 
 
 
  

NOTE: This is a single instance library. 

NOTE: This is a template type library. 

Range Default value 

0…240 60 

Range 

0…240 

 

 

 

Description 

Sets LCD backlight 

timeout 

Description 

Returns LCD 

backlight timeout 



 

 

6.3 HVAC Library structure in SoHVAC

The library structure in SoHVAC V

• Application libraries. This folder contains subfolders dedicated to HVAC control 
including ATV drive function blocks, compressor function blocks and function blocks 
related to energy monitoring. The new HVAC&R application function blocks are 
included in the installation process.

• Standard libraries. This folder contains the basic function blocks to build control logic 

• System libraries. This folder contains the function b
hardware 

 
 
 

y structure in SoHVAC 

The library structure in SoHVAC V3.0.0.0. is new organized. There are 3 main groups

Application libraries. This folder contains subfolders dedicated to HVAC control 
including ATV drive function blocks, compressor function blocks and function blocks 

to energy monitoring. The new HVAC&R application function blocks are 
included in the installation process. 

 

Standard libraries. This folder contains the basic function blocks to build control logic 

 

System libraries. This folder contains the function blocks related to the controller 

 

 

. is new organized. There are 3 main groups 

Application libraries. This folder contains subfolders dedicated to HVAC control 
including ATV drive function blocks, compressor function blocks and function blocks 

to energy monitoring. The new HVAC&R application function blocks are 

Standard libraries. This folder contains the basic function blocks to build control logic  

locks related to the controller 



 

6.4 Known issues 

 
Following issues are known in this field test version of the SoHVAC software / hardware and will be 
corrected in the next release
 
Priority 1 
Communication issue when downloading applications to t
During downloading of the application program an error message appears, indicating that the COM 
port cannot be opened. This error occurs on PC's which have SoMachine V4.1 installed.
Please contact your local support
 
Priority 3 
Wrong unit for OilRecoveryTime (SoHVAC HVAC
The unit is documented as seconds, but should be minutes
 
Priority 3 
Wrong unit in expansion bus 
The unit is documented as seconds, but should 
 
 
 
 
 

 

Following issues are known in this field test version of the SoHVAC software / hardware and will be 
release 

Communication issue when downloading applications to the controller on systems with Windows 7 
During downloading of the application program an error message appears, indicating that the COM 
port cannot be opened. This error occurs on PC's which have SoMachine V4.1 installed.
Please contact your local support if you have this error. 

Wrong unit for OilRecoveryTime (SoHVAC HVAC-R Function Library User Guide)
The unit is documented as seconds, but should be minutes 

expansion bus I/O Time-out (M168 Hardware User Guide) 
The unit is documented as seconds, but should be 0.1 seconds 

 

Following issues are known in this field test version of the SoHVAC software / hardware and will be 

he controller on systems with Windows 7  
During downloading of the application program an error message appears, indicating that the COM 
port cannot be opened. This error occurs on PC's which have SoMachine V4.1 installed. 

R Function Library User Guide) 


